Fisheries Management Decision Support System (FMDSS)

User’s Manual

By
Omar F. El-Gayar, Ph.D.
Fang Ji, Ph.D.
Fisheries Management Decision Support System (FMDSS)

User’s Manual

By

Omar F. El-Gayar, Ph.D.
Fang Ji, Ph.D.
Microsoft Windows 95, and Microsoft Excel 97 are trademarks of Microsoft Corporation. GAMS is a trademark of GAMS Development Corporation.
# TABLE OF CONTENTS

LIST OF FIGURES .................................................................................................................... V

ACKNOWLEDGMENTS ................................................................................................................ VI

CHAPTER 1 INTRODUCTION ................................................................................................... 1

CHAPTER 2 INSTALLATION AND CONFIGURATION ............................................................. 2
  2.1 SYSTEM REQUIREMENTS ............................................................................................. 2
  2.2 SETUP ........................................................................................................................... 2
  2.3 CONFIGURATION ......................................................................................................... 3

CHAPTER 3 FILE MENU ......................................................................................................... 5
  3.1 OPEN .............................................................................................................................. 6
  3.2 CLOSE ............................................................................................................................ 6
  3.3 SAVE .............................................................................................................................. 7
  3.4 SAVE AS ......................................................................................................................... 7
  3.5 REVERT .......................................................................................................................... 7
  3.6 PRINT SETUP ............................................................................................................... 8
  3.7 PRINT ............................................................................................................................. 8
  3.8 SOLUTION ANALYSIS ............................................................................................... 9
  3.9 EXIT ............................................................................................................................... 9

CHAPTER 4 EDIT MENU ......................................................................................................... 10
  4.1 UNDO ............................................................................................................................. 11
  4.2 REDO ............................................................................................................................. 11
  4.3 CUT ................................................................................................................................ 11
  4.4 COPY ............................................................................................................................. 12
  4.5 PASTE ........................................................................................................................... 12
  4.6 SELECT ALL .................................................................................................................. 12
  4.7 FIND ............................................................................................................................... 12
  4.8 FIND AGAIN ................................................................................................................ 13
  4.9 REPLACE AND FIND AGAIN ..................................................................................... 13
  4.10 REPLACE ALL ............................................................................................................. 13

CHAPTER 5 DATABASE MENU .............................................................................................. 14
  5.1 SELECT DATABASE ..................................................................................................... 15
  5.2 SAVE ............................................................................................................................. 15
  5.3 SAVE AS ......................................................................................................................... 15
  5.4 FLEETS .......................................................................................................................... 16
  5.5 TARGET SPECIES ...................................................................................................... 17
  5.6 AREAS ........................................................................................................................... 17
  5.7 SEASONS ....................................................................................................................... 18
  5.8 SPECIES ......................................................................................................................... 18
  5.9 LOCAL STOCK ............................................................................................................. 19
  5.10 MARKETS ................................................................................................................... 19
  5.11 CATCH .......................................................................................................................... 20
  5.12 SEASON LENGTH ...................................................................................................... 21
  5.13 OPERATING COSTS .................................................................................................... 22
  5.14 TRAVEL INFO ............................................................................................................ 22
    5.14.1 Travel days ........................................................................................................... 24
# LIST OF FIGURES

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1</td>
<td>FILE MENU</td>
<td>5</td>
</tr>
<tr>
<td>Figure 2</td>
<td>OPEN DIALOG</td>
<td>6</td>
</tr>
<tr>
<td>Figure 3</td>
<td>SAVE AS DIALOG</td>
<td>7</td>
</tr>
<tr>
<td>Figure 4</td>
<td>PRINT SETUP DIALOG</td>
<td>8</td>
</tr>
<tr>
<td>Figure 5</td>
<td>PRINT DIALOG</td>
<td>9</td>
</tr>
<tr>
<td>Figure 6</td>
<td>EDIT MENU</td>
<td>10</td>
</tr>
<tr>
<td>Figure 7</td>
<td>FIND DIALOG</td>
<td>12</td>
</tr>
<tr>
<td>Figure 8</td>
<td>DATABASE MENU</td>
<td>14</td>
</tr>
<tr>
<td>Figure 9</td>
<td>SELECT DATABASE DIALOG</td>
<td>15</td>
</tr>
<tr>
<td>Figure 10</td>
<td>Fleets Window</td>
<td>16</td>
</tr>
<tr>
<td>Figure 11</td>
<td>TARGET SPECIES WINDOW</td>
<td>17</td>
</tr>
<tr>
<td>Figure 12</td>
<td>AREAS WINDOW</td>
<td>17</td>
</tr>
<tr>
<td>Figure 13</td>
<td>SEASONS WINDOW</td>
<td>18</td>
</tr>
<tr>
<td>Figure 14</td>
<td>SPECIES WINDOW</td>
<td>18</td>
</tr>
<tr>
<td>Figure 15</td>
<td>LOCAL STOCK WINDOW</td>
<td>19</td>
</tr>
<tr>
<td>Figure 16</td>
<td>MARKETS WINDOW</td>
<td>20</td>
</tr>
<tr>
<td>Figure 17</td>
<td>CATCH WINDOW</td>
<td>21</td>
</tr>
<tr>
<td>Figure 18</td>
<td>SEASON LENGTH WINDOW</td>
<td>21</td>
</tr>
<tr>
<td>Figure 19</td>
<td>OPERATING COSTS WINDOW</td>
<td>22</td>
</tr>
<tr>
<td>Figure 20</td>
<td>TRAVEL INFO. SUB-MENU</td>
<td>23</td>
</tr>
<tr>
<td>Figure 21</td>
<td>TRAVEL DAYS WINDOW</td>
<td>24</td>
</tr>
<tr>
<td>Figure 22</td>
<td>FISHING DAYS WINDOW</td>
<td>24</td>
</tr>
<tr>
<td>Figure 23</td>
<td>TURN AROUND DAYS WINDOW</td>
<td>25</td>
</tr>
<tr>
<td>Figure 24</td>
<td>MODELING MENU</td>
<td>26</td>
</tr>
<tr>
<td>Figure 25</td>
<td>SELECT MODEL DIALOG</td>
<td>27</td>
</tr>
<tr>
<td>Figure 26</td>
<td>GOALS DIALOG</td>
<td>28</td>
</tr>
<tr>
<td>Figure 27</td>
<td>DECISION VARIABLES SUB-MENU</td>
<td>29</td>
</tr>
<tr>
<td>Figure 28</td>
<td>DECISION VARIABLES SELECTION DIALOG</td>
<td>29</td>
</tr>
<tr>
<td>Figure 29</td>
<td>SENSITIVITY ANALYSIS DIALOG</td>
<td>30</td>
</tr>
<tr>
<td>Figure 30</td>
<td>RUN SUB-MENU</td>
<td>32</td>
</tr>
<tr>
<td>Figure 31</td>
<td>TWO-STAGED OPTIMIZATION SUB-MENU</td>
<td>33</td>
</tr>
<tr>
<td>Figure 32</td>
<td>WINDOW MENU</td>
<td>34</td>
</tr>
<tr>
<td>Figure 33</td>
<td>HELP MENU</td>
<td>36</td>
</tr>
<tr>
<td>Figure 34</td>
<td>SELECT BASE SCENARIO DIALOG</td>
<td>37</td>
</tr>
<tr>
<td>Figure 35</td>
<td>SELECT CURRENT SCENARIO DIALOG</td>
<td>38</td>
</tr>
<tr>
<td>Figure 36</td>
<td>SAS MAIN CONTROL FORM</td>
<td>39</td>
</tr>
<tr>
<td>Figure 37</td>
<td>SAS PRINT MENU</td>
<td>39</td>
</tr>
<tr>
<td>Figure 38</td>
<td>SAS TOOLBAR</td>
<td>39</td>
</tr>
<tr>
<td>Figure 39</td>
<td>SOLUTION VISUALIZATION CONTROL FORM</td>
<td>40</td>
</tr>
<tr>
<td>Figure 40</td>
<td>PIVOT TABLE FORM EXAMPLE (FOR GROUP 1: CATCH, TQ, AND VCRATE)</td>
<td>41</td>
</tr>
<tr>
<td>Figure 41</td>
<td>PIVOT TABLE STRUCTURE</td>
<td>42</td>
</tr>
<tr>
<td>Figure 42</td>
<td>EDIT PIVOT TABLE DIALOG BOX</td>
<td>42</td>
</tr>
<tr>
<td>Figure 43</td>
<td>CHART FORM (FOR GROUP 1: CATCH, TQ, AND VCRATE)</td>
<td>43</td>
</tr>
<tr>
<td>Figure 44</td>
<td>PRE-DESIGNED REPORTS CONTROL FORM</td>
<td>45</td>
</tr>
<tr>
<td>Figure 45</td>
<td>SOLUTION COMPARISON CONTROL FORM</td>
<td>46</td>
</tr>
</tbody>
</table>
ACKNOWLEDGMENTS

To all those who contributed to this work by guidance, support, or help, we express our utmost gratitude.

We are deeply indebted to Professor PingSun Leung, Department of Agricultural and Resource Economics, University of Hawaii, for his constant effort, unlimited help, valuable influential advice, and his friendly encouraging way throughout the whole work.

Many thanks are due to Minling Pan at the Department of Agricultural and Resource Economics, University of Hawaii for her effort in collecting and streamlining the data needed by the system.

We would also like to thank Stuart Nakamoto and Sam Pooley for their valuable comments and suggestions.
CHAPTER 1 INTRODUCTION

FMDSS is a decision support system for analyzing the potential impact of limited entry programs on various Hawaii fisheries and on the economic performance of various fishing fleets. The system is comprised of three components: a dialog component, a modeling component, and a database component.

The modeling component, which represents the core of FMDSS, is a multi-level and multi-objective programming model of Hawaii’s multi-fishery (Pan et al. 1999). It was an extension of a linear programming model of Hawaii commercial fisheries originally developed by E.R.G. Pacific Inc. and subsequently modified and extended by National Marine Fisheries Service (NMFS). The primary features of the model incorporated in FMDSS over its earlier counterparts are that it is able to handle two issues that typically characterizes fishery policy problems:

1. More than one objective or goal that the decision-makers wish to optimize.
2. Decision-making at fishermen and policy levels, with policy-makers having incomplete control over all variables.

For more information on the FMDSS core model, please refer to JIMAR report by Pan et al. (1999).

The database component is comprised of a database management system and a database containing all data required by the model. Data pertaining to fishing fleets, target species groups, fishing areas, fishing seasons, and species are included in the database.

The dialog component represents the interface between the user and the other two components of the system, namely, the modeling component and the database component. The user interface is a graphical user interface (GUI) with pull-down menu structure that operates under Microsoft's Windows environment.

With respect to the modeling component, the user -through the user interface- can select the desired model specification, create a new model specification, modify an existing model specification, or build and run a model. In specifying a model, the user can select which goals or objectives to include in the model, select which fleet, target species, area, season, species, or any combination of thereof to include or exclude from the model.

With respect to the database component, the user -through the user interface- can select the desired database, create a new database, or modify an existing database. Database functions include adding, updating, deleting, searching, browsing, and listing database record entries.

Also considered a part of the dialog component is the Solution Analysis System (SAS). SAS is a sub-system specifically developed to allow the user to view, analyze, print and compare the solution of various scenarios.
CHAPTER 2 INSTALLATION AND CONFIGURATION

This chapter outlines the requirements for installing FMDSS for Windows and explains how to install and start FMDSS.

2.1 System Requirements

- 80486 processor (or higher).
- Mouse.
- 16 MB RAM (recommended 32 MB).
- Microsoft Windows 95.
- General Algebraic Modeling System (GAMS).
- Microsoft Excel 97.
- VGA or higher resolution monitor recommended.
- 6 MB of hard disk space (recommended 8 MB).

2.2 Setup

Before you install FMDSS, make a backup copy of the FMDSS disks by copying them to a second set of disks. Put the original disks in a safe place and use the copies as your working disks.

Use the Setup program SETUP.EXE to install FMDSS on your computer. To install FMDSS for Windows:

1. Start Windows.
2. Insert FMDSS Disk 1 into drive A and choose the Run option from the Windows Start-up menu. (If you are installing from another drive, please adjust the instructions accordingly).
3. In the Run dialog, type A:\ SETUP and press Enter.
4. Once Setup is initialized, it displays the Select Installation Directory and Group dialog, with a default drive, path and group specified. To change the drive or path, type the new drive or path in the Install In text box.
5. Click Continue to continue with the setup operation.
6. Insert additional disks as requested and follow the prompts that appear on your computer screen. When the installation is complete, you are ready to use FMDSS.
Click **Cancel Setup** at any point in the Setup process before files are actually copied to cancel with no changes made to your hard drive.

### 2.3 Configuration

For FMDSS to be able to solve GAMS models, GAMS has to be already installed and configured. To configure FMDSS to use the GAMS system already installed in the system:

1. Activate the Windows Explorer.
2. In the Windows Explorer, select the directory in which FMDSS is installed, e.g., 
   
   C:\FMDSS

3. Click the '+' symbol to expand the directory in which FMDSS is installed.
4. Select the GMS sub-directory, e.g.,
   
   C:\FMDSS\GMS

5. In the GMS sub-directory, select the file ‘GAMS’. This file is short cut to a MS-DOS program (GAMS).
6. With ‘GAMS’ selected, click the right button of the mouse to a short cut menu.
7. Select the **Properties** menu option to display the properties of the ‘GAMS’ short cut file.
8. In the Properties window, select the Program tab. The ‘cmd ln:’ field displays the MS-DOS command line for executing GAMS. The ‘working:’ field displays the default directory where the GAMS models under FMDSS are installed.
9. To change ‘cmd ln:’ or ‘working:’ fields, simply select the appropriate field and type the new entry, e.g.,
   
   Cmd ln: C:\GAMS\GAMS.EXE
   
   Working: C:\FMDSS\GMS

10. Click **OK** to save GAMS properties. FMDSS is now configured to run the GAMS system installed on your machine.

FMDSS uses Microsoft Excel 97 for solution visualization. For FMDSS to be able to access the Excel system as well as GAMS, an MS-DOS path has to be established to the directories in which the Excel and GAMS systems are stored. To update the ‘AUTOEXEC.BAT’ file:

1. Open the ‘AUTOEXEC.BAT’ file in the root directory of the booting drive, e.g., ‘C:\ AUTOEXEC.BAT’ with any text editor e.g., ‘Notepad’.
2. If the file already contain a path statement, add the two directories where Excel and GAMS are installed, e.g.,
C:\GAMS;C:\MSOFFICE\OFFICE

3. If the file does not contain a path statement, add a new line and type:

   PATH=<Excel path>;<GAMS path>

   Where =<Excel path> is the path where Excel is installed and <GAMS path> is
   the path where GAMS is installed, e.g.,

   PATH=C:\GAMS;C:\MSOFFICE\OFFICE

4. Save, and then close the ‘C:\ AUTOEXEC.BAT’ file.

5. Re-start the computer for the changes to take effect.

In some cases, the directory where the Excel program is under a directory structure which
contains directory names of length greater that eight characters, e.g.,

   C:\PROGRAM FILES\MICROSOFT OFFICE\OFFICE

To include such directory in a PATH statement, all directory names of length greater than
eight characters have to be truncated as follows:

   <First six letters of the directory name>--<Number>

Where ‘Number’ is an integer ranging from 1 to 9 that is used to distinguish between
directories having the same first six letters. The number is assigned according to the order
in which the directories appear in the directory tree displayed in Windows Explorer.

For example, the above directory will be included in the PATH statement as:

   C:\PROGRA~1\MICROS~1\OFFICE

If, for example, Windows Explorer shows that there is another directory named
MICROSOFT EXCHANGE that lies under the directory PROGRAM FILES and
MICROSOFT EXCHANGE is listed before MICROSOFT OFFICE, then the directory to
include in the PATH statement would become:

   C:\PROGRA~1\MICROS~2\OFFICE
CHAPTER 3 FILE MENU

The File menu contains options that allow you to create, open, save and otherwise manipulate the files on your disks. You can also enter printer information, print files, launch the SAS to inspect any scenario, and exit FMDSS through this menu.

Figure 1 File Menu
3.1 Open

Open allows you to open existing text files. When you choose this option, the Open dialog appears.

![Open Dialog](image)

This dialog displays all the files of a particular type (in a directory). Files that correspond to the specified extension are displayed in alphabetical order. If a file is already open, that file name is disabled in the list.

If you want to display all files in a directory, regardless of the extension, check the All Files check box. Now you can open any file that is saved in ASCII format, i.e., text files.

The first time that this dialog appears during a session, it displays the files in the default directory. If you change drives and/or directories, any time the dialog appears again it will display the same items as when you last closed it. To return to the default directory, you must choose that directory from the Directory list.

If the file you want to open is on a different drive, select the drive you want from the Drive popup. In the Directory list, choose the directory you want. The Open dialog displays the names of all files of the specified extension in that directory.

To open a file, Select it from the list and choose Select. To leave the dialog without opening a file, choose Cancel.

3.2 Close

Close closes the front-most file. You can also close a window by double clicking on the Control-menu box in the upper left corner of the window.
3.3 Save

Save stores any changes you have made to the current text file without closing the file. If more than one editing window is active, only changes to the front-most editing window are saved to disk.

Save is disabled when there are no open files or when no changes have been made since you last saved the front-most (current) file.

3.4 Save As

Save As... allows you to name and save a copy of a current file with a new name. Choose Save As... to display the Save As dialog.

![Save Dialog](https://example.com/save_dialog.png)

Figure 3 Save As Dialog

The current name of the file appears in the text box. Select the text box, then type a new name for the file and choose Save. A new text-editing window appears with the new file name as the window title. The old file is closed. If recent changes to the old file were not save before you created the new file, the changes do not appear in the old file but do appear in the new file. You can save a program or text file and translate it for use on another platform by checking the Change Code Page check box.

When in the Save As dialog, if you decide not to create a new file, choose Cancel to resume editing the current file.

3.5 Revert

Revert is enabled when you have made changes to a text file since the file was last saved. Choose Revert to replace the currently displayed file with the previous version. Before replacing the current version, FMDSS asks if you want to discard the changes.
Choose **No** to return to the current version or **Yes** to discard your changes and replace your current document with the previous version.

### 3.6 Print Setup

**Print Setup...** displays the Print Setup dialog.

![Print Setup Dialog](image)

Figure 4 Print Setup Dialog

In this dialog, you can select the default printer or a specific installed printer, as well as other options for your printer.

When you choose the **Options...** push button, the Options dialog is displayed. The Options dialog is different for each printer. For a description of the options specific to your printer, choose **Help** button while in the Options dialog. The Options dialog for some printers also has **Advanced...** or **Send Header** push buttons that bring up additional dialogs. Choose the **Help** push button in these dialogs for information on these options. For more information on setting up your printer, refer to the *Microsoft Windows User’s Guide*.

When your settings are correct, choose **OK** to activate them or choose **Cancel** to exit the dialog without changing the current print settings.

### 3.7 Print

**Print...** displays the Print dialog.
In this dialog, you can specify one of the following print sources:

- The contents of any open editing window
- The contents of a file that is not currently open
- The contents of an ASCII file
- The contents of the clipboard

Choose the sources from the **Windows** popup. To print the contents of a file that is not correctly open, choose the **File** option from the **Windows** popup. Then, in the text box, type the name of the file you want to print (including a full path if the file is in a different directory), or choose the **File...** push button and choose the file you want to print from the list in the Print File dialog.

If you choose to print the contents of an open editing window, the Justification (**Left**, **Center**, or **Right**) and Tab Size settings of the Preferences dialog will affect the output.

When the Line Numbers check box is checked, FMDSS automatically adds line numbers to the output.

When the **Page Eject Before** check box is checked, FMDSS sends a form feed to the printer before printing. When the **Page Eject After** check box is checked, FMDSS sends a form feed to the printer after printing.

Once the settings in the Print dialog are correct, choose **OK** to confirm your choices or **Cancel** to exit the dialog without taking action.

### 3.8 Solution Analysis

**Solution Analysis** launches the Solution Analysis System (SAS). For more information on SAS, refer to the *chapter on SAS in this manual*.

### 3.9 Exit

**Exit** ends your FMDSS session and returns you to the Windows desktop.
CHAPTER 4 EDIT MENU

Edit menu options are useful for editing text. You can use Edit menu options to edit text in editing windows and text in text editing regions in dialogs.

Figure 6 Edit Menu
4.1 Undo

*Undo* reverses the last action that you performed on any text within a field, file, or text editing regions in dialogs. If you choose *Undo* repeatedly, actions will be reversed all the way back to the start of the current editing session.

In the context of *Undo* and *Redo*, an action is defined as:

- Pressing Delete or Backspace key.
- Selecting then pressing Delete or Backspace.
- Selecting then starting to type replacement text.
- Moving the cursor and typing.
- Any sequence of keystrokes besides those listed above that you make before pressing the Spacebar and typing.
- Choosing one of the following *Edit* menu options: *Cut*, *Paste*, *Clear*, or *Replace All*.

If you choose *Undo* an action and then change your mind, you cannot restore the text to its previous form by choosing *Undo* again. To reverse an *Undo*, choose *Redo* from the *Edit* menu.

If you choose *Undo* to reverse the action of the *Replace All* option, all changes made during the replace are removed. *Replace All* is treated as one action.

When *Undo* has reversed all the actions performed in the current session, it is disabled. When you save a file or close a file and re-open it, the *Undo* option is disabled until you make additional changes.

4.2 Redo

*Redo* is the opposite of *Undo*. If you change your mind after you *Undo* an action, choose *Redo* to restore the text to its previous conditions.

If you *Undo* several actions in a row, choosing *Redo* repeatedly will redo actions in the reverse order that they were undone. The definition of an action for *Redo* is identical to the definition for *Undo*.

4.3 Cut

*Cut* removes selected text from any field, file or editing regions in dialogs. The text is placed on the clipboard. Use *Cut* when you want to remove a selection from one location and place it in a different location using *Paste*. 
4.4 Copy

Copy duplicates the selection (without removing it) and places the copy on the clipboard.

4.5 Paste

Paste insets a copy of the clipboard contents into the current file or field at the cursor location. If text is selected and you choose Paste from the Edit menu, the contents of the clipboard replace the selected text.

4.6 Select All

When you choose Select All from the Edit menu, FMDSS selects:

- Everything in an editing window if the editing window is front-most.
- Everything in the current text editing region if a dialog is front-most.

4.7 Find...

Find... displays the Find dialog so that you can search for text in the current editing window.

![Find Dialog]

Figure 7 Find Dialog

In the Find dialog, specify a word or phrase that you want to find in the Look For text box. If you would like FMDSS to replace the text it finds with a different piece of text, specify the replacement text in the Replace With text box. You do not have to specify Replace With text if you just want to locate text. If you do specify Replace With text, you do not have to use it for every occurrence you find.

In the Find dialog you can also specify the following options:

- **Ignore Case**: Locates the word with any combination of upper- and lower-case letters. If you do not check this check box, FMDSS only locates the text exactly matching the text you specified.

- **Wrap Around**: Searches the file from the cursor location to the end of the file, then wraps around to the beginning of the file and searches to the original cursor
position. **Wrap Around** allows you to search the entire file without first positioning the cursor at the beginning of the file.

- **Match Whole Word**: Locates occurrences of the exact letter combination as specified in the Look For text box. For example, if you told FMDSS to search for “can” and did not check **Match Whole Word**, it would find any phrases that contain “can”, such as “candle”, and “decanter”. If you check this check box, only exact occurrences of the word “can” are found.

- **Search Backward**: Searches the file from the current file position backwards, toward the beginning of the file. If this check box is not checked, FMDSS searches the file forward, from the current file position to the end of the file.

When you have entered the appropriate information in the Find dialog, Choose **Find** to begin the search or **Cancel** to exit the dialog without taking action.

When FMDSS finds a match, it highlights the matching text for you to see. You can edit the text using FMDSS editing techniques.

### 4.8 Find Again

After FMDSS locates the text string you specified in the Find dialog, you can choose **Find Again** to locate the next occurrence of the string. **Find Again** is enabled only after you enter text in the **Look For** text box of the Find dialog and choose **Find**. The keyboard shortcut for **Find Again** is Ctrl+G.

### 4.9 Replace and Find Again

**Replace and Find Again** replaces a matching string of **Look For** text with the **Replace With** text that you specified in the Find dialog, then continues to search for the next occurrence of matching text. **Replace and Find Again** is enabled only after the first Find is executed. When FMDSS finds the next match, it pauses again to await instructions.

If you do not want to replace this specific match, choose **Find Again** instead of **Replace and Find Again**. You can also use the Ctrl+E key combination as a shortcut when replacing and finding text again.

### 4.10 Replace All

**Replace All** replaces every occurrence of a matching string of **Look For** text with the **Replace With** text that you specified in the Find dialog. It does not pause and ask about replacing the text each time it encounters a match. This option is enabled only after you choose **Find...** from the **Edit** menu.
CHAPTER 5 DATABASE MENU

Database menu options allow you to manipulate FMDSS databases.

Figure 8 Database Menu
5.1 Select Database

Select database displays the Select Database dialog box so that you can select the database you wish to work on.

![Select Database Dialog]

Figure 9 Select Database Dialog

The Select Database dialog box is similar to the Open File dialog box from the File menu with the exception that FMDSS database files are not in ASCII format (i.e., not text files) and have a default extension of "DB". For more information on the Select Database dialog box, refer to the Open section of the chapter entitled File menu.

Upon selecting a database file, FMDSS decompresses the selected database file. The name of the currently selected database is now displayed on the title bar at the top of the screen and the database is now ready for use by FMDSS.

5.2 Save

Save saves the currently selected database. Save is enabled only after a database has been selected.

5.3 Save As

Save As... allows you to name and save a copy of the current database with a new name. Choose Save As... to display the Save As dialog.

The Save As dialog box is identical to the Save As dialog box from the File menu with the exception that FMDSS database files are not in ASCII format (i.e., not text files) and have a default extension of "DB". For more information on the Save As dialog box, refer to the Save As section of the chapter entitled File menu. Save As is enabled only after a database has been selected.
5.4 Fleets

Fleets displays the Fleets window which allows you to add, update, display, and delete fleets entries in the Fleets master file in the currently selected database.

![Fleets Master File]

Figure 10 Fleets Window

The push buttons at the bottom of the Fleets window allows you full control over the Fleets file in the currently selected database:

- **Prev**: Displays the previous record in the Fleets file. If the record pointer already points to the first record (beginning of file), this button is disabled.
- **Next**: Displays the next record in the Fleets file. If the record pointer points to the last record (end of file), this button is disabled.
- **List**: Displays a list of all the fleets in the Fleets file.
- **Find**: Displays the Find dialog so that you can search for a particular record in the Fleets file.
- **Add**: Appends empty record to the Fleets file.
- **Undo**: Reverses the last action that you performed.
- **Save**: Stores any changes you have made to the current Fleets file without closing the file. This button is disabled when no changes have been made since you last saved the file.
- **Exit**: Closes the fleets file and returns to FMDSS main menu.

5.5 Target Species

**Target Species** displays the Target Species screen which allows you to add, update, display, and delete target species entries in the Target Species master file in the currently selected database.

![Figure 11 Target Species Window](image)

The push buttons at the bottom of the Target Species window are identical to those on the Fleets window. For more information on the function of these buttons, refer to the Fleets section in this chapter.

5.6 Areas

**Areas** displays the Areas window which allows you to add, update, display, and delete areas entries in the Areas master file in the currently selected database.

![Figure 12 Areas Window](image)
The push buttons at the bottom of the Areas window are identical to those on the Fleets window. For more information on the function of these buttons, refer to the Fleets section in this chapter.

5.7 Seasons

**Seasons** displays the Seasons window which allows you to add, update, display, and delete seasons entries in the Seasons master file in the currently selected database.

![Seasons Window](image)

Figure 13  Seasons Window

The push buttons at the bottom of the Seasons window are identical to those on the Fleets window. For more information on the function of these buttons, refer to the Fleets section in this chapter.

5.8 Species

**Species** displays the Species window which allows you to add, update, display, and delete species entries in the Species master file in the currently selected database.

![Species Window](image)

Figure 14  Species Window
The push buttons at the bottom of the Species window are identical to those on the Fleets window. For more information on the function of these buttons, refer to the Fleets section in this chapter.

5.9 Local Stock

**Local Stock** displays the window that allows you to add, update, display, and delete local stock information in the currently selected database.

![Local Stock Window](image)

Figure 15 Local Stock Window

The push buttons at the bottom of the Local Stock window are identical to those on the Fleets window. For more information on the function of these buttons, refer to the Fleets section in this chapter.

5.10 Markets

**Markets** displays the window that allows you to add, update, display, and delete market information in the currently selected database.
Figure 16 Markets Window

The push buttons at the bottom of the Markets window are identical to those on the Fleets window. For more information on the function of these buttons, refer to the Fleets section in this chapter.

5.11 Catch

Catch displays the window that allows you to add, update, display, and delete catch information in the currently selected database.
Figure 17 Catch Window

The push buttons at the bottom of the Catch window are identical to those on the Fleets window. For more information on the function of these buttons, refer to the Fleets section in this chapter.

5.12 Season length

Season length displays the window that allows you to add, update, display, and delete season information in the currently selected database.

Figure 18 Season Length Window
The push buttons at the bottom of the Season length window are identical to those on the Fleets window. For more information on the function of these buttons, refer to the Fleets section in this chapter.

5.13 Operating Costs

**Operating Costs** displays the window that allows you to add, update, display, and delete operating cost information in the currently selected database.

![Fleet-Target species detail file](image)

Figure 19 Operating Costs Window

The push buttons at the bottom of the Operating Costs window are identical to those on the Fleets window. For more information on the function of these buttons, refer to the Fleets section in this chapter.

5.14 Travel info.

**Travel info.** displays a sub-menu that allows you to choose which travel information you want to edit: travel days, fishing days, or turn around days.
Figure 20 Travel Info. Sub-Menu

Upon selection of the desired data item, FMDSS displays a window that allows you to add, update, display, and delete the selected data item in the currently selected database.
5.14.1 Travel days

![Travel Days Window](image1.png)

Figure 21 Travel Days Window

5.14.2 Fishing days

![Fishing Days Window](image2.png)

Figure 22 Fishing Days Window
5.14.3 Turn around days

![Fleet-Target species-Area detail file](image)

Fleet #: 001
Fleet name: Small recreational boats
Target species #: 001
Species name: Yellowfin tuna
Area #: 001
Area: Around MHI (20 nmi)

Turn around days: 23.00

Figure 23 Turn Around Days Window

The push buttons at the bottom of these windows are identical to those on the Fleets window. For more information on the function of these buttons, refer to the Fleets section in this chapter.

5.15 Import DB from Excel

Import DB from Excel imports data into the currently selected database from a corresponding set of files in Excel version 4.0. For more information on database and Excel file names and structures, refer to Appendix 2 of this manual.
CHAPTER 6 MODELING MENU

The **Modeling** menu allows you to create, select and save model specification files, to define models, to perform sensitivity analysis, and to build and run the current model.

![FMaSS](image)

**FMaSS**

A Fisheries Management Decision Support System

Copyright 1997

Figure 24 Modeling Menu
6.1 New

New lets you create and open a new model specification file. The extension ‘SPC’ is reserved for model specification files. When you choose this option, FMDSS creates a new model specification file with the default name “TEMP.SPC”. You can then save the file under a different name using Save As.

6.2 Select model

Select model allows you to open existing model specification files. When you choose this option, the Select model dialog appears.

![Select Model Dialog]

The Select model dialog box is similar to the Open File dialog box from the File menu with the exception that FMDSS model specification files are not in ASCII format (i.e., not text files) and have a default extension of “SPC”. For more information on the Select model dialog box, refer to the Open section of the chapter entitled File Menu.

Upon selecting a model specification file, FMDSS displays the name of the currently selected model on the title bar at the top of the screen and the model is now ready for use.

6.3 Save As

Save As... allows you to name and save a copy of the current model specification file with a new name. Choose Save As... to display the Save As dialog.

The Save As dialog box is identical to the Save As dialog box from the File menu with the exception that FMDSS model specification files are not in ASCII format (i.e., not text files) and have a default extension of “SPC”. For more information on the Save As dialog box, refer to the Save As section of the chapter entitled File Menu. Save As is enabled only after a model has been selected.
6.4 Goals

Goal allows you to select decision attributes (goals), assign weights that signify the relative importance of each of the attribute to the planner, and to set target values representing an a-priori desired aspiration level. Goals is enabled only after a database and a model have been selected. When you choose this option, the Goals dialog appears.

![Goals Dialog](image)

Figure 26 Goals Dialog

A weight value of zero signifies the exclusion of the corresponding decision attribute from the model and automatically disables the corresponding target field.

When your settings are correct, choose OK to save them in the current model specification file or choose Cancel to exit the dialog without changing the current settings.

6.5 Decision variables

Decision variables displays a sub-menu from which you can select a decision variable set.


Figure 27 Decision Variables Sub-Menu

When you choose any of the five available decision sets, a corresponding dialog similar to the one shown below is displayed (shown here for the Fleets set)

Figure 28 Decision Variables Selection Dialog
The **Available** list (left list) contains all entries in the current database that are available for selection, i.e., not yet included in the current model. Upon selecting any entry, the **Add** button is enabled allowing you to move the entry to the **Selected** list (right list).

The **Selected** list contains all the entries that are selected and thus included in the current model. Upon selecting any entry, the **Remove** button is enabled allowing you to move the entry to the **Available** list.

When your settings are correct, choose **OK** to save them in the current model specification file or choose **Cancel** to exit the dialog without changing the current settings.

**6.6 Sensitivity analysis**

**Sensitivity analysis** allows you to analyze the sensitivity of the solution to changes made in some critical parameters such as catch per unit effort (CPUE), price of fish, and level of stock. It also allows you to select particular combinations to include in the model. When you choose this option, the Sensitivity analysis Dialog is displayed.

![Figure 29 Sensitivity Analysis Dialog](image)

**Entries to be affected** displays two sets of lists. The **Available** set of lists (left lists) and the **Selected** set of lists (right list). Each set contains five lists representing the five entities in the model, namely: Fleets, Target species, Areas, Seasons, and Species.
The **Available** set of list contains all entries in the current database that are available for selection, i.e., not yet included in the current model. Upon selecting any entry, the **Add** button is enabled allowing you to move the entry to the **Selected** list (right list).

The **Selected** set of lists contains all the entries that are selected and thus included in the current model. Upon selecting any entry, the **Remove** button is enabled allowing you to move the entry to the **Available** list.

**Variables to be changed** allows you to choose which parameter is to be changed. To choose a particular parameter, simply click on the corresponding radio button. Only one parameter can be chosen at any one time. Depending on the dimensionality of the parameter selected, some of the **Available** and **Selected** lists will be disabled. For example, Price is a three dimensional parameter (Fleets, Seasons, and Species), thus upon selecting the list corresponding to Target species and Areas are automatically disabled. Of particular importance in the variable list is the Restriction flag. This is a five dimensional parameter (Fleets, Target species, Seasons, Areas, and Species) which is used to include or exclude the selected entry combinations from the model. Assigning a value of "0" will exclude the selected entry combinations from the model. For more information on model parameter and variables, refer to Appendix 1 of this manual.

**Type of change** allows you to select the desired change. **Percentage increase/decrease** will increase/decrease the value of the parameter chosen by the percentage indicated in the **Amount of change field**. Set to will set the value of the parameter chosen by the value indicated in the **Amount of change field**. The change will affect the values for the parameter chosen for all possible combination in the **Selected** set of lists. For example, if price is the parameter chosen, and two fleets, three seasons, and four species are in their corresponding **Selected** lists, then the change will affect a total of 2*3*4=24 price entry.

When your settings are correct, choose **OK** to save them in the current model specification file or choose **Cancel** to exit the dialog without changing the current settings.

### 6.7 Build

**Build** translates the current model specification file as well as the data stored in the current database into format readable by the GAMS sub-system. The model is then ready to be solved using any of the MCDM techniques incorporated in FMDSS. **Build** is enabled only after a database and a model have been selected.

### 6.8 Run

**Run** activates a sub-menu from which you can choose between two model formulations.
The model formulations are:

- **Constant catch rate** model in which catch rate per unit effort (CPUE) is constant irrespective of current stock levels.

- **Variable catch rate** model in which CPUE varies with the change in the current stock levels.

For each of the two model formulations, you can choose between the following options:

- **Weighted objective optimization** in which the objective function optimized is the weighted sum of all objectives selected in the model.

- **Two-staged optimization** is enabled only when the second objective is selected. In this option the solution proceeds in two stages. The first stage optimizes the second objective alone. The second stage fixes the level of the second objective at the value attained by the first stage and then optimizes any of the remaining seven objectives according to the following screen.
Figure 31 Two-Staged Optimization Sub-Menu
CHAPTER 7 WINDOW MENU

The **Window** menu options are used to control windows as well as provides access to all windows open by FMDSS.

Figure 32 Window Menu
7.1 Close

Close closes the active window.

7.2 Cycle

Cycle rearranges open windows to bring successive ones to the front. When you choose Cycle, the frontmost window moves to the back and the next window that was originally opened becomes the frontmost window. Continue to choose Cycle until the window of your choice is frontmost.

7.3 Other options

The names of all open windows appear at the bottom of the Window menu. If an open window is hidden or behind other windows, you can bring it to the front by choosing its name from the Window menu. If the window is minimized this will also restore it to its previous display size.
CHAPTER 8 HELP MENU

The Help menu provides on-line help for the user.

Figure 33 Help Menu
CHAPTER 9 SOLUTION ANALYSIS SYSTEM

The Solution Analysis System (SAS) contains options that allow you to view, print, and compare the solution of various scenarios. The system is comprised of three main components: solution visualization, pre-designed reports, and solution comparison.

To be able to run SAS you have to have Microsoft Excel 97 installed on your system. You also need to establish a path to the directory that contains Excel as shown in the installation and configuration chapter of this manual.

To launch SAS, select the Solution Analysis menu option from the File menu. When you choose this option, two dialogs similar to the Open File dialog appear consecutively. The first dialog allows you to select the solution file for the base scenario, i.e., the main scenario that will be used by all three components of SAS.

![Figure 34 Select Base Scenario Dialog](image)

The second dialog allows you to select the solution file for the current scenario, i.e., the scenario that will be compared with the base scenario and is thus only used by the Solution comparison component of SAS. If you are interested in launching SAS with only one scenario, select that scenario as the base and current scenario.
Figure 35 Select Current Scenario Dialog

The Select Base/Current scenario dialog box is similar to the Open File dialog box from the File menu with the exception that FMDSS scenario files are not in ASCII format (i.e., not text files) and have a default extension of "SNG". For more information on the Select Base/Current scenario dialog box, refer to the Open section of the chapter entitled File Menu. Upon selecting the base and desired scenario files, FMDSS launches SAS with the selected scenario files.
**Figure 36 SAS Main Control Form**

**SAS** Main control form allows you to activate any of SAS’s three components by clicking on the corresponding button as well as quitting the system and going back to FMDSS. By selecting the Print menu from SAS menu bar, the SAS Print menu appears.
Figure 37  SAS Print Menu

The **Print** menu is available as long as **SAS** is active. It contains options that allows you to setup print page, set and clear print area, print preview, and print the selected print area exactly as you would do by using these options under Excel. For more information on Excel's print options, refer to the *Excel's User Manual* or *Excel's online Help*.

Also available throughout a **SAS** session is a toolbar that allows you to access any of SAS's three components at anytime irrespective of where you are in the system.

![SAS Toolbar Diagram]

*Figure 38  SAS Toolbar*
9.1 Solution visualization

Upon selecting Solution visualization by pressing the corresponding button in the SAS Main control form or on the SAS toolbar, a control form containing a list of available views appears.

![Solution Visualization Control Form](image)

Figure 39  Solution Visualization Control Form

The Solution visualization component allows you to inspect all important parameters and variables in the underlying optimization model. Due to the multi-dimensional nature of the model (in which the dimension of some parameters/variables ranges from two to five), it is inappropriate to simply list the parameters/variables in a two-dimensional form on screen.

Instead, the Solution visualization component groups all variables with the same dimension into one group. A total of six groups are available. By selecting the corresponding button, you can the view the selected group of parameters/variables in pivot table format or chart them using various chart types.

9.1.1 Pivot tables

A pivot table is a table that is used to display large amounts of data in various views. A pivot table can display database data in almost any configuration and any form that you
choose. The pivot table is one of the most advanced data analysis tools available in any software product or development environment.

<table>
<thead>
<tr>
<th>Sum of VCRATE</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fish</td>
<td>Around Mill (20 mm)</td>
</tr>
<tr>
<td>Aku</td>
<td>7,278.84</td>
</tr>
<tr>
<td>Charter boats</td>
<td>3,145.00</td>
</tr>
<tr>
<td>Commercial handline</td>
<td>3,508.00</td>
</tr>
<tr>
<td>Commercial trolling</td>
<td>3,505.00</td>
</tr>
<tr>
<td>Longline boats (length &lt; 13,900 mm)</td>
<td>845.00</td>
</tr>
<tr>
<td>Longline boats (length &gt; 13,900 mm)</td>
<td>13,900 mm</td>
</tr>
<tr>
<td>Small commercial boats</td>
<td>251.00</td>
</tr>
<tr>
<td>Small recreational boats</td>
<td>174.37</td>
</tr>
</tbody>
</table>

Figure 40  Pivot Table Form Example (For Group 1: CATCH, TQ, and VCRATE)

The diagram below shows the structure of a pivot table:

```
```
For the pivot table shown (for group 1), the row and column areas list all fleets and areas in the model respectively, while the page area designates the selected target species, season and species. The data area displays the values of the parameter/variable indicated by the option button on the right most of the pivot table form (which is TQ).

Three controls on the pivot form make it easier for you to manipulate the pivot table: option buttons, list box, and control buttons. Option buttons in the upper right portion of the pivot table allows you to easily control which parameter/variable is displayed in the table’s data area. When you select one of the displayed option buttons, the parameter/variable corresponding to the selected option button replaces the currently displayed one. Depending on whether the selected parameter/variable can be summed, a grand total row and column may or may not appear.

The list box in the upper right portion of the form displays four options for calculating the parameter/variable displayed in the table’s data area. When you select Normal, data is displayed as normal — that is, without any calculation applied. When you select \% of Row, data is displayed as percentages going across the rows of the table, with all the values in a single row adding up to 100 percent. When you select \% of Column, data is displayed as percentages going across the columns of the table, with all the values in a single column adding up to 100 percent. When you select \% of Total, data is displayed as percentages throughout the table, with all the values in the table adding up to 100 percent. If the selected parameter/variable cannot be summed, then data can be displayed as Normal only.

The pivot form has three buttons: Control, Chart, and Edit Table. Control takes you back to the Solution Visualization Control Form while Chart takes the user to the Chart Form. The Edit Table displays a dialog box named Edit Pivot table.
The Edit Pivot Table dialog box allows you to either rebuild the original pivot table or launch the pivot table wizard to make manual changes to the pivot table. This dialog box also allows you to refresh the data in the pivot table. The dynamic nature of the pivot table allows you to change its every aspect. The Edit Pivot Table dialog box, however, lets you backtrack. With this dialog box, you can reconstruct the original pivot table if, for example, the table has been changed so much that it cannot be returned to its original configuration manually (for example, if you deleted a pivot field by dragging it out of the Table area). In addition, access to the Pivot Table Wizard through this dialog allows you to take advantage of this powerful built-in functionality of Excel. And with the Refresh Table checkbox, you can ensure—without having to exit and restart the application—that the data being analyzed is current.

9.1.2 Charts

The Chart button on the pivot table form takes you to the Chart Form. The Chart form shows graphically the data from the pivot table. The chart on the Chart Form is linked to the pivot table. When the structure of the pivot table changes, the chart changes as well reflecting the new pivot table data.
Figure 43 Chart Form (For group 1: CATCH, TQ, and VCRATE)

Two controls on the pivot form make it easier for you to manipulate the chart form and the corresponding pivot table: drop-downs and option buttons – first group. The two drop-down objects at the top of the Chart form correspond to the two Page field drop-down list-boxes on the Pivot form. In fact, the items that populate the two drop-down list boxes on the Chart form are identical to the pivot items in the Area and Season pivot fields in the pivot table's Page area. By selecting a value from one of the two drop-down list boxes on the Chart form, you can change the corresponding page field drop-down list box on the pivot table to display the selected item. It should be noted that these two drop-downs can handle up to two pivot fields in the Page area of the pivot table.

The first group of option buttons at the upper left corner of the Chart form can be used to change the parameter/variable that is displayed in the pivot table's data area, thereby changing the data displayed on the chart.

When you first enter the Chart form, the drop-down, option button objects are set to reflect the data as it is displayed in the pivot table. For example, if the Area category was in one of the pivot table's page fields and if 'Between 222 and 22' was selected as the current page, the drop-down on the Chart form that corresponds to the Area pivot field displays the text "". In addition, on the Chart form, the option buttons that correspond to
various parameters/variables that can be displayed in the pivot table’s Data area are set to reflect the data that is actually in the table.

In addition to the objects that control how data is displayed in the pivot table, other objects on the Chart form control properties of the chart itself: option buttons – second group and scroll bars. The second group of option buttons on the Chart form allows you to select the desired chart type. Four different chart types are available column or bar chart, surface chart, area, and line charts. All four charts are displayed in three-dimension form (3D).

The two Scroll bars at the lower left portion of the Chart form allows you to rotate the entire chart any direction so that the chart can be viewed from different angles.

To return back to the corresponding pivot table, simply click on the Pivot button at the upper right corner of the Chart form.

Similar forms are available for the other groups of parameters/variables.
9.2 Pre-designed reports

Upon selecting Pre-designed reports by pressing the corresponding button in SAS main screen or on SAS toolbar, a list of available reports appears.

![Pre-Designed Reports Control Form](image)

Figure 44 Pre-Designed Reports Control Form

9.3 Solution comparison

Upon selecting Solution comparison by pressing the corresponding button in SAS main screen or on SAS toolbar, a list of available reports appears.
Figure 45 Solution Comparison Control Form
## APPENDIX 1 LIST OF MODEL PARAMETERS AND VARIABLES

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTTRIP</td>
<td>actual trips per vessel per year by fleet</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>AESDT</td>
<td>parameter for switching between seasons</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>AL</td>
<td>catch by area and species</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>CATCH1</td>
<td>catch by species</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>CATCH2</td>
<td>catch distribution in seasons by area and species (ratio)</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>CATCH3</td>
<td>stock distribution in seasons by area and species (ratio)</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>CATCHFA</td>
<td>distribution of total catch by fleet and area</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>CATCHFS</td>
<td>distribution of total catch by fleet and season</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>CHACATCH</td>
<td>total catch from charter boat</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMCATCH</td>
<td>total commercial catch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COST</td>
<td>total cost per trip ($/trip)</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>FC</td>
<td>fixed cost</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>FCS</td>
<td>share of fixed cost in the considered seasons</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FEDT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FESDT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FLEETC</td>
<td>total cost by fleet</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>FLEETFC</td>
<td>total fixed cost by fleet</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>FLEETR</td>
<td>total revenue by fleet</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>FLEETVC</td>
<td>total variable cost by fleet</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>FLT</td>
<td>fleet number in number</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>FLTMST</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FTAEDT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FTAEG</td>
<td>equal 1 when Opcost<em>Rd</em>Seasln<em>Td</em>Fd is positive</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>FTAESDT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FTAESFG</td>
<td>equal 1 when Opcost<em>Rd</em>Seasln<em>Td</em>Fd*Catch is positive</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>MAXNTR</td>
<td>maximum trip revenue</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>MAXTRIP</td>
<td>number of trips</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>MAXTRIPREV</td>
<td>maximum trip revenue</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>OVERCREW</td>
<td>over expected profit for crew</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>OVEROWNE</td>
<td>over expected profit for owner</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>RATIO1</td>
<td>resource utilization ratio by fleet and area and species</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>RATIO2</td>
<td>ratio of actual catch quantity to local stock area and season and species</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>RATIO3</td>
<td>ratio of actual catch quantity to local stock area and species</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>REAL1</td>
<td>actual catch quantity by fleet and species and area</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>REAL2</td>
<td>real catch by species and area</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>RECCATCH</td>
<td>total recreational catch from fleets 1 and 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>REVFA</td>
<td>distribution of total revenue by fleet and area</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>REVFS</td>
<td>distribution of total revenue by fleet and season</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>SCOEFF</td>
<td>stock coefficient</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STOCK1</td>
<td>stocks by area and species</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>STOCK2</td>
<td>stocks by species</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>STOCK3</td>
<td>stock distribution in seasons by area and species</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>STOCK4</td>
<td>stock distribution in seasons by species</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Index</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------</td>
<td>-------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>catch rate coefficient (decimal)</td>
<td>I</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CQ</td>
<td>catch quantity per trip (1000 lbs)</td>
<td>J</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CGSR</td>
<td>catch quantity saturation ratio (decimal)</td>
<td>K</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CREW</td>
<td>binary variable for determining crews entry (dimensionless)</td>
<td>L</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EFFCREW</td>
<td>expected revenue for crew in $1E6</td>
<td>S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FRCREW</td>
<td>revenue for crew in $1E6</td>
<td>I</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NRCDIFF</td>
<td>over expected revenue for crew in $1E6</td>
<td>J</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NRODIFF</td>
<td>net revenue for owner after accounting for fixed cost in $1E6</td>
<td>K</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OWNER</td>
<td>binary variable for determining owners entry (dimensionless)</td>
<td>L</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>REVENUE</td>
<td>revenue per trip with 10% deducted ($1000 per trip)</td>
<td>S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEROFLEET</td>
<td>expected revenue for owner (fixed cost) in $1E6</td>
<td>I</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TNR</td>
<td>net revenue per trip ($1000 per trip)</td>
<td>J</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TQ</td>
<td>total catch quantity (1000 lbs)</td>
<td>K</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TRIP</td>
<td># of trips</td>
<td>L</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TROFLEET</td>
<td>revenue for owner in $1E6</td>
<td>S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VCRATE</td>
<td>catch rate (lbs per fishing day)</td>
<td>I</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESSEL1</td>
<td># of vessels</td>
<td>J</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESSELS2</td>
<td># of vessels by season</td>
<td>K</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESSEL3</td>
<td>fleet size annually (vessels)</td>
<td>L</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y</td>
<td>binary variable for entry condition</td>
<td>S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## APPENDIX 2 DATABASE FILE STRUCTURE

Structure for table: `c:\fmdss\fltmst.dbf`
Number of data records: 9
Date of last update: 04/09/97
Memo file block size: 64
Code Page: 0

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FLT_NO</td>
<td>Character</td>
<td>6</td>
<td>2</td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>NAME</td>
<td>Character</td>
<td>10</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>3</td>
<td>MEC</td>
<td>Numeric</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CC</td>
<td>Numeric</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>CT</td>
<td>Numeric</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>CR</td>
<td>Numeric</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>CM</td>
<td>Numeric</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>NC</td>
<td>Numeric</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>ERC</td>
<td>Numeric</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>VP</td>
<td>Numeric</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>VL</td>
<td>Numeric</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>ERO</td>
<td>Numeric</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>NOTES</td>
<td>Memo</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Total:** 90

Structure for table: `c:\fmdss\tspmst.dbf`
Number of data records: 10
Date of last update: 04/09/97
Code Page: 0

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TSP_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>NAME</td>
<td>Character</td>
<td>30</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
</tbody>
</table>

**Total:** 34

Structure for table: `c:\fmdss\areamst.dbf`
Number of data records: 5
Date of last update: 04/09/97
Memo file block size: 64
Code Page: 0

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AREA_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>NAME</td>
<td>Character</td>
<td>30</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>3</td>
<td>NOTES</td>
<td>Memo</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Total:** 44

Structure for table: `c:\fmdss\seasmst.dbf`
Number of data records: 4
Date of last update: 04/09/97
Memo file block size: 64
Code Page: 0

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SEAS_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>NAME</td>
<td>Character</td>
<td>30</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>3</td>
<td>LENGTH</td>
<td>Numeric</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>NOTES</td>
<td>Memo</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Total:** 47

Structure for table: `c:\fmdss\spmst.dbf`
Number of data records: 14
Date of last update: 04/09/97
** Memo file block size: 64 **

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SP_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>NAME</td>
<td>Character</td>
<td>30</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>3</td>
<td>STOCK</td>
<td>Numeric</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>NOTES</td>
<td>Memo</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

** Total **

** Structure for table: c:\fmdss\ftdt.dbf **

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FLT_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>TSP_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>3</td>
<td>OPCOST</td>
<td>Numeric</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>NOTES</td>
<td>Memo</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

** Total **

** Structure for table: c:\fmdss\fedt.dbf **

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FLT NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>SEAS_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>3</td>
<td>SEASLN</td>
<td>Numeric</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

** Total **

** Structure for table: c:\fmdss\aesdt.dbf **

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AREA_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>SEAS_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>3</td>
<td>SP_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>4</td>
<td>LOSTOCK</td>
<td>Numeric</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>NOTES</td>
<td>Memo</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

** Total **

** Structure for table: c:\fmdss\fesdt.dbf **

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FLT_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>SEAS_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>3</td>
<td>SP_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>4</td>
<td>P</td>
<td>Numeric</td>
<td>5</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>NOTES</td>
<td>Memo</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

** Total **

** Structure for table: c:\fmdss\ftadt.dbf **

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FLT_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>SEAS_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>3</td>
<td>SP_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>4</td>
<td>P</td>
<td>Numeric</td>
<td>5</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>NOTES</td>
<td>Memo</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

** Total **

** Structure for table: c:\fmdss\ftadt.dbf **

Number of data records: 47
Date of last update: 04/09/97
Memo file block size: 64
Code Page: 0
Field Field Name Type Width Dec Index Collate
1 SP_NO Character 3 Asc Machine
2 NAME Character 30 Asc Machine
3 STOCK Numeric 6
4 NOTES Memo 10
** Total **

** Structure for table: c:\fmdss\ftdt.dbf **

Number of data records: 47
Date of last update: 04/09/97
Memo file block size: 64
Code Page: 0
Field Field Name Type Width Dec Index Collate
1 FLT_NO Character 3 Asc Machine
2 TSP_NO Character 3 Asc Machine
3 OPCOST Numeric 5
4 NOTES Memo 10
** Total **

** Structure for table: c:\fmdss\fedt.dbf **

Number of data records: 36
Date of last update: 04/09/97
Memo file block size: 64
Code Page: 0
Field Field Name Type Width Dec Index Collate
1 FLT NO Character 3 Asc Machine
2 SEAS NO Character 3 Asc Machine
3 SEASLN Numeric 3
** Total **

** Structure for table: c:\fmdss\aesdt.dbf **

Number of data records: 280
Date of last update: 04/09/97
Memo file block size: 64
Code Page: 0
Field Field Name Type Width Dec Index Collate
1 AREA_NO Character 3 Asc Machine
2 SEAS_NO Character 3 Asc Machine
3 SP_NO Character 3 Asc Machine
4 LOSTOCK Numeric 8
5 NOTES Memo 10
** Total **

** Structure for table: c:\fmdss\fesdt.dbf **

Number of data records: 504
Date of last update: 04/09/97
Memo file block size: 64
Code Page: 0
Field Field Name Type Width Dec Index Collate
1 FLT_NO Character 3 Asc Machine
2 SEAS_NO Character 3 Asc Machine
3 SP_NO Character 3 Asc Machine
4 P Numeric 5 2
5 NOTES Memo 10
** Total **

** Structure for table: c:\fmdss\ftadt.dbf **

Number of data records: 164
Date of last update: 04/09/97
Memo file block size: 64
Code Page: 0

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FLT_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>TSP_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>3</td>
<td>AREA_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>4</td>
<td>RD</td>
<td>Numeric</td>
<td>5</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>NOTES</td>
<td>Memo</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

** Total ** 25

Structure for table: c:\fmdss\faedt.dbf
Number of data records: 132
Date of last update: 04/09/97
Memo file block size: 64
Code Page: 0

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FLT_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>AREA_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>3</td>
<td>SEAS_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>4</td>
<td>TD</td>
<td>Numeric</td>
<td>5</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>NOTES</td>
<td>Memo</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

** Total ** 25

Structure for table: c:\fmdss\ftaedt.dbf
Number of data records: 652
Date of last update: 04/09/97
Memo file block size: 64
Code Page: 0

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FLT_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>TSP_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>3</td>
<td>AREA_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>4</td>
<td>SEAS_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>5</td>
<td>FD</td>
<td>Numeric</td>
<td>5</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>NOTES</td>
<td>Memo</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

** Total ** 28

Structure for table: c:\fmdss\ftaesdt.dbf
Number of data records: 1532
Date of last update: 04/09/97
Memo file block size: 64
Code Page: 0

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>Type</th>
<th>Width</th>
<th>Dec</th>
<th>Index</th>
<th>Collate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FLT_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>2</td>
<td>TSP_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>3</td>
<td>AREA_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>4</td>
<td>SEAS_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>5</td>
<td>SP_NO</td>
<td>Character</td>
<td>3</td>
<td></td>
<td>Asc</td>
<td>Machine</td>
</tr>
<tr>
<td>6</td>
<td>CATCH</td>
<td>Numeric</td>
<td>8</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>INCLCFG</td>
<td>Numeric</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>NOTES</td>
<td>Memo</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

** Total ** 35
Reference